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What is ParaView? 2

ParaView is a free interactive visualization package produced by KitWare,
https://www.kitware.com/

It is built upon VTK, the Visualization Toolkit, https://vtk.org/

It uses a dataflow paradigm:
Source . - -
Data —-l Filter |—~| Filter |—-| Sink

In which data arrives via sources (typically files), is filtered by various
numeric algorithms, and is sent to various sinks (typically the computer
graphics display).

Besides the interactive interface, ParaView also has a Python scripting
interface, so that you can create these dataflow networks auto-magically.

These notes have been written

A against ParaView version 5.11
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http://www.paraview.org 3
Click here to download ParaView

Unleash the Power
f ParaVi
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In these notes, what do these icons mean? 4
scalar.csv scalar.ogv

They tell you that if you go to our notes web site:

http://cs.oregonstate.edu/~mjb/paraview

you will find pre-created ParaView input data (*.csv) and pre-created animation
movie files (*.ogv).

You can read a .csv file right into ParaView so that you can experiment with these
examples without having to first create them yourself.

You can play an .ogv movie file right from your browser so that you can see how
these examples look without having to run ParaView at all.
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A warning about me and the Notes

What ParaView does

What | know

What the
notes cover

Computer Graphics
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Screen Layout, Color Editor,
and 3D Display

4
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In the Beginning, there was OpenDX ...
5

|
4 [

— ;_IJ ﬁ =

|

_IJJ

Ore;

“DX” stands for “IBM Data Explorer”. Like the name implies, it let you explore! But,
once it became “open” instead of commercial, all reliable support went away. Also, it
required a lot of screen area just to hold the block diagram.

Computer Graphics
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Fan-In to the Full Scene

OpenDX: ParaView:
Pipeline Browser
| [ buitin:
_IJ B ml scalar,csv
i TableToStructuredarid1
S | |
rl =8 Threshold1
e Wl
& Contour
[l ]
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ParaView Screen Layout
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ParaView Menus
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Window Layout Menu

Computer Graphics

o fis e S VR TR i it A L =
¥ & | 30 Qe = R A Gy 6T N SV
. J
S—~— Y
Camera undo
and redo Add, subtract,
and toggle
Toggle between Adjust selecti?)?\s Selecting cells, points, Clear
2D and 3D camera and blocks selection
interaction
Save Split a window Splita window up- Maximize a Restore after
screenshot left-right down window maximizing
Eliminate a
/ window
RenderViewl = D (%]
9 l
§9
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Commonly-used Filters Menu

12

HOPPREEO =P

Contour

A

<z
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Calculator Clip

Threshold

Slice Extract Subset

Glyph Warp by Vector

Stream Tracer Group Datasets

Some will be activated and some will be greyed-out, depending on what
data you would be trying to use them for

Extract Level
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ParaView Menus

ADPIDMDE e

Animation Controls

13

RS Teg @@

) & W F

Apply Load
Open Save (S;:\{;yst Disconnect Undo Changes Color
Save State State Automatically ~ Palette
Save Reset )
Extracts ~ Connect  Session Redo ord
Matching
+xﬁ 21 ey 1’]5 s2ft -z
a= = e |
Directional Camera Positions
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ParaView Menus
n E 2 :l._—‘—l“:‘vl .\:.‘_r"./ % t‘-=-‘." = Elevation - SILtI"faCE ¥
Color Use Rescale  Rescale Graphical
Legend  Separate 0 Custom o visible Representation
Visibility ~ Color ~ Data Data

Map Range Range

Edit Rescale Rescale What to
Color  to Data to Data Color
Map Range Range Based
over all On
Time
Steps
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ParaView Menus

X @ W

Reset Zoom
Reset Camera to Box
Closest
Zoom Zoom
to Closest
Data to Data

B 0 S &

. Plot
Compute Histogram Over
Quantities Line
Plot
Extract .
; Variables
Selection
Over
Time
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Probe Ruler
Location
Plot . Programmable
Selection .
Filter
Over
Time
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3D Scene Manipulation

A

i
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B ParaView 580

e Edt View Soures Fiters Iools Camysm Matros Hep

T

=
R ®

s S

(=Rl A RNl 7 ERF M4

Sources —» Geometric Shapes — Sphere 7

I Wine I I pick Solid Color x
= = N Basic colors 4
== Properties (Sphere1) 2]
e [ I[o @
e sicon 37
Nt Resoigion (39 /
== Display (GeometryRepresentation) = |
Repre |5, -
QL so conr S -] |
C [ b 5 LA EET R i & GRS Hue: [0 |* Red: (255 &
:y:;;g sat: |0 2| Greem: (255 ¢
't Val: | 255 |5 Blue: | 255 ||
Lighting 2
O Add to Custom Colors ML i
T
Computer Grﬁphics e
™ — August 25, 2023
H : 18
3D Scene Manipulation
By default, these are the 3D Scene Manipulators
(plus the mouse wheel, which is also a Zoom):
(You can change these in the Edit » Settings —» Camera menu)
/
3D Interaction Options /
Camera3 DManipulators: Select how interactions are mapped to camera movements when in 3D
interaction mode.
Left Button Middle Button Right Button
'Roiate - '-Pan ~ || Zoom -
shift + [l + | [Rotate ~ | pan -
Ctrl + | Zoom - | |Rotate ~ || ZoomToMouse -
Oty
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You Can Change Sphere Properties

If the Apply button is
highlighted, click it to make
Properties Tab ~ your changes take effect

Show/Hide the
Geometric Properties

/

<7 The Geometric Properties of the Sphere
Oregon State
Universil
Computer Graphics jb — August 25, 2023
mijb - August 25,

20

You Can Change the Sphere’s Display Properties

A\

[ = View (Render View)

& _isplay [ o =+=r Show/Hide the Display Properties

e
Coloring "
~ How to Color the Sphere

T Edit the Sphere Color

~ How to Represent the Sphere

~
Set the Sphere Opacity

[~ Set the Sphere Specular Lighting

Use Scale Array

~ Bring up other Features to Color-Edit

ind 4
éﬂ‘jﬂ“’;‘i_m = ~ Edit the Edge Color

Carcer Auces W ~~ Show/Hide the Render View Properties
ion Axes
V] rientation Axes Visilky. [~ Edit the Features of the Axes Grid

e e Remove I~ Tum on/off the Axes Grid
Camera Parafisl Projection

Ray Traced Rendering
Enable Ray Tracing

UTIIVETSICY
Computer Graphics
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The Axes Grid

ParaView has a nice Axes Grid feature.
Scroll way down in the Properties area to
the Render View menu to turn it on.

| = vigh (Renderview |3 o] [l

( [~] Axes Grid ) Edit
Enter Axes Visibility

7
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Editing the Axes Grid

22
Show more/less

options

= View (Render View) "@' Dol

M axesarid | € Edit p

] Center Axes Visibility

M edit

h .. (use Esc to clear text)

V| Visibility

Titles for the axes 1

Title font styles -

Cull Backface:

v/ Cull Frontface

Number label font styles ]

V| Label Unique Edges Only

Faces To Render

Aves To Label

~[[100 [|]|B||1||S

&
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Editing the Axes Grid

pre— e — I Edit
= View (Render View) ‘ oo | ad
Axes Grid [ Edit =
7 X Axis Label Font Properties bt
[acel

] Center Axes Visibility

Y Axis hﬁ'{ﬂltmpeﬂiﬁ Sec o
Title font styles ’é Tocel. —

[ Tomiclzonpoperies
P
X Az
¥ Audis Use Custom Labels
Y Axis Label Properties
Y Aws Notation Fmsi

Y AxisPrecision |1
¥ Ais Use Custom Labels
Z Axis Label Properties .

Z s Notation

Number label font styles /

5 X
5, 2023
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Filters — Alphabetical —» Shrink

Be sure the Shrink eyeballs
|_— are clicked on and the Sphere
eyeballs are clicked off

Pipeline Browser
T

B builtin:

77 @ spheret

< B

/ Step #1: Set the Shrink Factor (1. = no shrinking, 0. = all shrinking)

|_— Step #2: Hit Apply

Properties \ Information

Properties E®
®oeete || 2] |

[Search ... use Esc to clear text) /

== Properties (Shrif

Shrink Factor ey | |0 5
[ — _ ' —]

== Display (UnstructuredGridRe | | [ |

Representation [ o

Coloring

| ® solid Color

«

Dregon State
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Are You Getting Tired of Hitting Apply All the Time? %

In Edit — Settings — General, turn on Auto Apply

B settings

: General >Camera Render View Color Arrays Color Palette

Search ... (use Esc to clear text)

General Options

v Show Welcome Dialog: Show welcome screen at startup.
Show Save State On Exit: Prompt to save state when exiting ParaView.

crash.

that all the filters are selectable on low resolution screens.
GUI Font
Override Font: Override the GUI font size. Uncheck to use system default.

View Options

Crash Recovery: On a crash, attempt to save a state file to potentially restore the application state to that before the

Force Single Column Menus: Force the sources/filters menus to be presented as a single scrollable column to ensure

Default View Type: Set the view to create when ParaView starts up.

Render View

and other 2D annotations.

96

Screen Pixels Per Inch: Set pixels per inch on the current screen/monitor. This is used for determining pixel sizes for fonts

e e "
< Properties Panel Options \
v Auto Apply: Automatically apply changes in the 'Properties=pafiel.

Show
more/less
options

Be careful about doing this with large datasets that are slow to display. |

Don'’t do this until after you have completed the entire TableToStructuredGrid operation. |

Universil
Computer Graphics
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Visualizing Scalar Data, |

scalar.csv
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What File Formats Can ParaView Read? 2
AVS UCD BYU CML Molecule C csv D
DEM DICOM ENZO AMR Particles EnSight
Enzo ExoduslIReader FLASH AMR Particles FacetReader
Flash Fluent Case Gaussian Cube Image
JPEG Series LSDynaReader Legacy VTK MFIXReader
MRC Series Meta File Series NetCDF Nrrd
OpenFOAMReader PDB PLOT3D PLY
PNG Series PTS PVD Particles
Partitioned Legacy VTK Phasta ProSTAR (STARCD) RTXMLPolyDataReader
Restarted Sim SLAC Spcth History STL
Spy Plot TIFF Tecplot Unstructured NetCDF POP
VPIC VRML Wavefront OBJ WindBlade
XDMF XML XYz
Oregon State
Universil
Computer Graphics
mjb — August 25, 2023
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Creating Scalar Data in a CSV File

-0.94,-1

-0.74,-1

-0.55,-1

-0.35,-1

-0.16,-1

X32,Y¥32,232,s
-1.00,-1.

-0.87,-1.
-0.81,-1.

-0.68,-1.
-0.61,-1.

-0.48,-1.
-0.42,-1.

-0.29,-1.
-0.23,-1.

-0.10,-1.
-0.03,-1.

00,-1.00,0.00
.00,-1.00,0.00
00,-1.00,0.00
00,-1.00,0.00
.00,-1.00,0.00
00,-1.00,0.00
00,-1.00,0.00
.00,-1.00,0.00
00,-1.00,0.00
00,-1.00,0.00
.00,-1.00,0.00
00,-1.00,0.00
00,-1.00,0.00
.00,-1.00,0.00
00,-1.00,0.00
00,-1.00,0.00

Go to the Edit —» Settings menu and turn on Auto-Apply.
Do a File - Open and navigate to your CSV file.

Hit the Apply button to actually do the read.

2

Oregon State
University
Computer Graphics

scalar.csv
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Reading and Converting the CSV File 2

B ParaView 5.9.1 s e il
W Gl
~1. Select File - Open and |, | . & .
navigate to scalar,csv N
Pipeline Browser {=2E] o ja : ::i: :
E?|builtin: non o ema
T
2. Then, click Apply AT TeslT
 SrmmTEn

/

3. This will bring up a table window to confirm
that the data has been read properly. You can
close it if you want.

Properties | Information
Properties @

| & apply @ Reset % Delete

e

E*E

Oregon State
Universil
Computer Graphics
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Reading and Converting the CSV File %0

Pipeline Brovser (B
@ buitin:

( ; 1 sm.m.mdcrm 4. Now, go to
_ — Filters » Alphabetical - TableToStructuredGrid

5. Fill in the Whole Extent boxes showing the first

and last index in each dimension (the last index is one
/ less than the number of points in that dimension). In
roferties | information this case, the numbers are 0 and 31.

6. Fill in the {X,Y,Z} Column information so ParaView
knows how to make your 3D display. In this case, the
names are X32, Y32, and Z32.

7. Hit the Apply button to actually do the conversion.

Fipeline Browser
i ¥ 2 T
qdl‘_“__ @ builtin:
% Turn on the “eyeballs” so [ scalar.csv
: . —_ N
DrUefiS:hi?at you can view this data @t Pt S RaE e
Computer Graphics
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Reading and Converting the CSV File 3

5
[ buitin:
D scalarcsv

@ W TebleTostructuredcrid1

»»Renderview1 ||

Properties Information
Froperties CE

Apply @ Reset # Delete

clear tex]

Q
=

== Properties (TableToStructur

Whole Extent |y S

o 5

o 5
XColumn | g = =
YCohmn | g ya =
I = — =

= Display

Representation | ouine

. \ The default Display Representation is Outline.
@@ Click here and try some of the others. Point Gaussian is cool! |
<G

Oregon State At this point, you should probably go to the Edit

Con%rllljt‘grgigphics — Settings menu and turn off Auto-Apply

As Point Gaussian 32

(e "‘ dsh

N

Oregon State
University = 0.0e+00
Computer Graphics
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A Side Trip:
Choosing Colors

ray

Oregon State
Universil
Computer Graphics
mjb — August 25, 2023
Turni Col S
urning on Coior
The default coloring is by scalar value, S in this case.
Propesties. BT Dol You can also clickhere and change it to Solid Coloring.
Properties B

@ Reset

== Display (StructuredGridRepr:
Representation | point Gaussian

Coloring

Styling
Opadty

Ray Tracing
Scaling Mode All Approximate
Point Gaussian

Gaussian RIS ey | .01

Shader Preset [ gphere

Data Axes Grid

® Delete

/The Edit button

will bring up a color map editor

Array Name: S

Automatic Rescale

Range Mode
Interpret Values As Categories

Grow and update on

Rescale On Visiility Change

Mapping Data

noph’ e

SEICH e A EIED

1
= L . o
Data: [0
x ~ Enable freehand drawing of opacity transfer function
). Use log scale when mapping data to colors.
- Enable opacty mapping for surfaces
Use log scale ‘mapping data to opacity
Edi Data Histogram

Oregon State
University
Computer Graphics

7o
%{9 This is a ro

\

w of color options.

Display data histogram

Autor

Number of bins: «

compute

Color Mapping Parameters.

Color Space

Opian color

Nan Opacity

Diverging

mjb — August 25, 2023
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Choose Among Standard Color Transfer Functions %

Click herg to see all the categories of Transfer Functions
u. Click All to see them all at once.
croll down a lot.)

(You will need

R Choose Preset 7 x

Presets Presets

- — - [ P
B oo sion P
[ p— [
[ P—— [

Apply
- =T [ R —

Import
(- =

Remove

Actions on selected:

Show cutrent preset
in default mode

Jet

Tip: <dlick> to select, <double-dlick> to apply a preset. Close
Computer Graphics

mjb — August 25, 2023

Color Map Editor —= =

Array Name: §

B RS o ot e o oy =
Interpret Values As Categories
Rescale On Visbiity Change

Mapping Data

Select a color map from defauit presets -

Col?ar Transfer
Function' Sculptin

C| |58 |w e
¥ Ik k L5 ! Enable Freehand Drawing Of Opacity Transfer Function

Use Log Scale When Mapping Data To Colors

Enebie Opaciy Mapping For Surfaces
Lse Log Scale Vihen Mapsing Data To Opecity
it 20 Transfer Functon
Data Histogram
Diplay Data Hitogram
Automaticaly Recompute Dats Htogram
Number ofgins: < 0
Color Mapping Parameters
CoorSosce | Dwergng -
Oan Color
Nan Opadty 1[x

Color D

V| Discretize

Number Of Table
Values

University FIRAE Render iews [
Computer Graphics
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Changing the Legend

The default legend is good, but you can
make it better. Start by clicking here.

— 0.0e+00

i
Sl
Oregon State

Universil
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Changing the Legend

\Click on the “gear” to bring up all of the options.
- (This is a good idea on all ParaView dialog boxes.)

\

s > Legend title and font

| ____— Color bar
/ Tick mark font and number format (“printf-style”)

D>

/ Range numbers at the end of the legend

D

old oy || heee || Xona |[ Poc |
mjb — August 25, 2023
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From this, to this

Temperature

en
o
o

Computer Graj
mjb — August 25, 2023
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Visualizing Scalar Data, Il

CS

scalar.csv

University
Computer Graphics
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As Points

Computer Graphics
mjb — August 25, 2023

Pipeline Element and Filter Observations 42

»  Whatever pipeline element you have most-recently clicked on, that's what Properties
you will see.

Whatever pipeline element you have most-recently clicked on, that will be the parent of
the next Filter you select. The parent’s output will become the Filter’s input.

Be careful of Filter order. In general, Filters are not commutative or associative.

For data-size reasons, it is helpful if any datasize reduction Filters are included early in
the pipeline.

As far as | can tell, you can'’t inject a filter in the middle of a pipeline. You can re-parent
it. You can delete it and pipeline elements around it and start over. But, adding a new
Filter between two existing pipeline elements creates a tee from the parent, not a new
pipeline.

»  Whatever “eyeballs” you have clicked on, that’s what pipeline elements’ visual
representations you will see in the display.

* Turn on the TableToStructuredGrid “eyeballs” and set the Representation to Outline.
That keeps ParaView displaying the data as 3D-fullsize, regardless of what downstream
pipeline elements do.

Dregon State
University
Computer Graphics
mjb — August 25, 2023
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Right-clicking on a Pipeline Element 43

ipeline Browser
T
[ buitin:
i
5 scalar.csv

% Open
# Show All
Hide All

< % Delete —>
# Delete Downstream Pipeline

Rename
Reload Files
Change File
Ignore Time
Change [nput...

g Add Filter >
Properties ‘ In reate Custom Filter..,

roperties Link with selection

i1 Apply @ Reset | % Delete

~3

[ N £ y
{Search .., {use Esc to dear text)

Coloring
oll.s -
o i mjb — August 25, 2023
As a Glyph Cloud 4
= - — ., ] Filters » Alphabetical — Glyph adds the glyph cloud to
= v telt) (S92 H Y e bineline. Hide the TableToStructuredGrid (click off the
e I -hide the Glyph.
o oe e —— = eyeball) and un-hide the Glyp
E:Ti?‘ih“" | @ o orientation array = Set the Glyph Type
Scale

Scale Array | @ No scale array

e T |
[
e o |
Paints
Seed 110339 /|
| = Display (GeometryRepresent | =1 1 O/ |
Representation | sucface —

Coloring

\V 25

i B Edit
Styling

 Opacity e | 0.86
Lighting

Specular T e

) Play with the Opacity

Play with the Scale Factor

r Play with the Glyph Mode

mpb — August 25, 2023
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Computer Gre
mjb — August 25, 2023

As a Threshold Glyph Cloud 46
B bt Click on TableToStructuredGrid, then Right-click —
5 scalarcsy / Add Filter - Alphabetical » Threshold.
* -EEGW But, this is the wrong order. We want to threshold the
@ ata first. So, select Glyph1, right-click on it, select

Change Input...

#f Change Input Dialog
Then select Threshhold1
Select Input

T
[ scalar.csv /
* TablaToStructuredGridl

You now have this order

"
Oregon State
University
Computer Graphics
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As a Threshold Glyph Cloud 47

Hide the TableToStructuredGrid and the Threshold,

g builltin: / then un-hide the Glyph.
| scalar.csy

Set the Minimum and Maximum. (Be sure to click
on Apply if needed.)

Use Continuous Cell Range

Invert

\?_/’
Oregon State
Universil
Computer Graphics
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<= ® 1 —
DL aa—

Show Plane
ingin |0 0
Normal| 1 I}
Mote: Use 'P' to pick 'Origin’ on my
the closest mesh point

X Normal

¥ Normal
Z Normal
Reset Camera to Normal

Reset to Data Bou,

Offset |

Crinkle slice
| Triangulate the slice

V| Merge duplicated paints in the slice

v
Oregon State
Universil
Computer Graphics

As a Colored Cutting Plane

ParaView trick — turn on the TableToStructuredGrid display
and set the Representation to Outline. That keeps ParaView

\ from displaying the plane as 2D-only

~ Right-click on TableToStructuredGrid, then
select Add Filter » Alphabetical — Slice

 Click in here to change the slice parameters.

49

Click on the colored plane itself to move the plane.

Click on the arrow to rotate the plane

mjb — August 25, 2023

i
[H builtin:
\

= scalar.cev

C é TableToStructuredGrid1

é Slice 1

Oregon State
University
Computer Graphics

Turning the Slice into Contours

Right-click on Slice1, then select

/ Add Filter — Alphabetical - Contour

50

mjb — August 25, 2023
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Changing the Contour Isovalue

Value Range: [0, 153,579

1 /30
2 0

3 18.773333333333333

| — Add a contour isovalue

| ___— Delete a contour isovalue
| Add a range of contour isovalues

51

Isosurfaces
8 Generate Mumber Series /? X Value Range: [0, 166.01]
T T2
Range il iD .‘,t‘
o I —
lo | - 166,01 2 | 10:445609530402175 ‘_‘
- B I -
i |
T == = 3 |56.39121965080435
Number of Samples: |10 | 55.33682049120653
5 |73.7824303216087
[
|6 |92.22304915201068
Sample series: 0, 18.4456, 36.8912, 55.3368, 73.7824,
92.228, 110.674, 129.119, 147.565, 166.01 |11087365358241306
i 129.11926861281522
|
|
9 [1475888786432174
- = —
Generate || Cancel | 10/166.01048647361%6 * 0 [x || |
mib — August 25, 2023
As Contours 52

Coloring

Representation C‘;Tlﬂreﬁ'ame 4%—,
v

| This needs to be Wireframe to
get contour lines

Coloring by S will give you
colored contour lines.

Coloring by Solid Color will glve
you a single color. \ /

Oregon State
University
Computer Graphics
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Wﬂw— As Contours >
Liltin:
sﬁlar.sv

tructuredGrid 1

ﬁs\iml
L

Clicking on the Slice filter will bring up these slice handles so
that you can move and re-orient the slice plane

>

Click on the plane itself to move the plane.
Click on the arrow to rotate the plane.

<G
Oregon State
Universil
Computer Graphics
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As Contours o4

Computer Graj
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As Contours %5

Styling
Opadity L~

<L Line Width |3—'R‘L >

™ Render Lines As Tubes

/ Adjusting the Line Width

Lighting

Specular — 'ﬁ,ﬂ

4 |

i
\E}f/
Oregon State

Universil
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P As 3D Isosurfaces

Fscar.csv
< - ﬁ:z;sf“ ————— Note —This instance of Contour needs to be parented
Contourt from TableToStructuredGrid, not Slice

Contour2

Cont

e = PAT=TE Add an isosurface isovalue

Cobmry o o -] Delete an isosurface isovalue
e %dd a range of isosurface isovalues

Compute Gradients.

V| Gen, riangles / /

Wralue Range: [0, 168.9]

18448

Coloring

s 5 -

s Edit

Styling

Opacity —— ) 1

Lighting
Specular

8/25/2023
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Computer G

dgust 25, 2023

Using the Calculator to Duplicate S to be Able to %8
Color by Scalar Value

Add a Calculator filter parented by TableToStructuredGrid. The
|~ isosurface Contour2 should be parented by the Calculator.

In the Calculator, this is like saying: Scalar = S

Properties | Information J
Properties
\ ¥ Apply @) Reset M Delete ’F |
| sedch ... (us " text) || 2

rties (Calculatorl) | E8 .

Attribute\lype | . pgint Data - |

Gear | (| ) | at | jHa | ket |
£ . - il 4
g | tan | abs | sqrt |+
asin | acos ! atan | ceil | floor I,

| sinh | cosh 1[ tanh ' wy : axp J’ i |
\E:r?/ vivz | miag I norm ; In L logi0 I !
Oregon State | Scalars - ‘ Vectors o
Universil
Computer Graphics
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Using the Calculator to Duplicate S to be Able to
Color by Scalar Value

59

/ Now change the Coloring to color by Scalar instead of S.

/

Value Range: [0, 168.96]

Computer G}ayphics

mjb — August 25, 2023

AlS
&

Computer Graphwes

2
3
2
2
]
a
£
&
2

60
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Coloring

| o Scalar ‘

[ e | |_||:||-_-||_|I_||J e

Stylin:

Lighting
N ———0 |

Dnegon State
University
Computer Graphics

Experimenting with the Opacity and Specular is Fun Too ©

How the Calculator Works 62

= Properties {Calculator 1) | |§‘ ik |§| ‘E| ”

Attribute Mode ipmt Data

[] Coordinate Results

Name of the

asin”acns”atanllceﬁ ||ﬁooq’||

sh | cosh | || wh | xy | ew |

output field

|~ X, Y, and Z unit vectors

A list of the current
vector variables in
the dataset

[ vivz || mag norm || n | Joglﬂ [l
Scalars - hd Vectors
&2

A list of the current

Dmg"“s““e scalar variables in
University
Computer Graphics the dataset

mjb — August 25, 2023
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As a Volume 83
ﬁ} buiftin: pr——
E scalar.csv

# ) TableToStructuredGridl

B Slicet

é Contourl
W) Calculatort

ﬁ(‘,ontourz | 27.097:0,000
L v
== Display (StructuredGridRepn ‘_=| E|E! Data: [27.0974 |
— e
(( Representation :Voluy - |
Coloring
ql=s - | =
T Y B3 B EY| E Y
L Bav Tracing
Dresmte :
Universil
Computer Graphics
mjb - August 25, 2023
Sculpting the Alpha Transfer Function o4

Hover over the black line and left-click to add a new sculpting point there

Hover over a point and hit the Delete key or Middle Mouse
Button to delete a point

Mapping Data
Alpha=1.
\ (opaque)
\ 27.097:0.000
&
J s
Alpha=0.
Data: |27.0974 | (transparent)
a7
&
v’ Data value range
Oregon State
University
Computer Graphics
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65

Temperature

5]
(=]
(=]

Computer Srap
mjb — August 25, 2023

IsoVolumes 66

Pipeline Broviser

 buitn Start with this
[ scalar.csv
" W TableToStructuredGridl

ﬁ Contourl

D Calculatort

The IsoVolume properties start out at “allow all values”
to pass through. We’'re going to change this.

IsoVolumel

| chose the Surfaces with Edges
representation so you can see the cells,
You'll see why in a moment.

\
| II=I\mperl:iﬁ (IsoVolume1) |'|3 o :. A

Input Sclars | o ¢

N

[FEpresentation \ | surface With Edges
e — - -

Coloring

ios -

s Edit

ol

2
2
s
3
&
E
2

University
Computer Graphics
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IsoVolumes &7
Now adjust the Minimum and Maximum to
[ "= properties (tsovolumez) Qlﬁlﬂlil / something else.
InputSGelarsl a5 d
Representation ISurface With §dges
l€ Note that the IsoVolume filter turned your nice,
efficient structured grid into an unstructured
grid. This can balloon the size of the data that
is being operated on.
B—August 25, 2023
68
\\%!f/
Oregon State
University
Computer Graphics
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]

B buitin:
5 scalarcsy
- ﬁ'rable‘ruswm:edcrm
3 é}@ slice1
b Contourl
D Calculator1
éCnnlnurz
IsoVolumel

®
T
@ D AnnotateTimeFiltery

Adding Titles

Add an Annotate Time Filter to the pipeline

69

The default annotation looks like this. We will change that.

For

shift o

Text Prop Mode

Arial

== Properties (AnnotateTimeFilter1)

(& Time: {time:f}

Scale |1

== Display (TextSourceRepresentatiol

2D Text Widget

¥| Interactivity

Text Position

® Lise Window Location
™ Iy
™ ¥

Use Coordinates

0.05 [0.05

Font Properties
~ [ [3]lO [ree [2][BI[ 1 |[S ][] ]

Show Background | Only on hover

Q
|

T T

Time: 0.0000000

mjb — August 25, 2023

Adding Titles

/ \

== Properties (AnnotateTimeFilterl) C
Format Tipe: fime-£.
— =
Shitt 0
Scale |1
== Display (TextSourceRepresentatiol e

TextPropMode | 2D Text Widget

| Interactivity

ln.os

|0.05

\, ==

S

Arial -1 2]l |+t [2|[B]/ 1 IS || &

Show Background | Only on hover

"=

=

| The label to use (the printf-notation is to format
the Time — get rid of this if you just want a title)

~ The position for the title

The font, size, color, opacity, style, and

—  justification to use

Oregon State
University
Computer Graphics

mjb — August 25,
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71

From this:
Time: 0.000000

to this:

Oregon State
University
Computer Graphics
mjb — August 25, 2023
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Multiple Views

University
Computer Graphics
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Multiple Views &

Step #1: Split the Window

re_ o Ve TCamp )

Bar Chart View
Bar Chart View (Comparative)
Bax Chart view
Eve Dome Lighting
Histogram View
Line Chart View
Line Chart View (Comparatrve)
Orthograghie Sice View

parallel Coordinates view

Pio Matrix View
Point Chart View
Pythan View
Quartile Chart View
Shice View
Spreadsheet View
Oregon State
University
Computer Graphics
mjb — August 25, 2023
Multiple Views I
prl?ﬁl_llti Browser Pipeline Browser
ﬁl builtin: [ buitin:
£ st D s

- éTahleTnStmchAredGridl

> ﬁ TableToStructuredGrid1

= W calaulatory / W Calculatori
= jc»ntum @ | B contoun
#* | L Glypht = i Glyph1

Step #3: Click in one Window  Step #4: Click in the other Window and setup a separate

and setup one visualization visualization (stay aware of how the visualizations are parented!)
By

... and, you get this —
with each Window
being allowed its own
viewing transformation

Oregon State
University
Computer Graphic|

mjb — August 25, 2023
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Multiple Views with Linked Viewing Transformations  ”°

Step #5: Right-click in one of

the Windows and select Click on another view to link with,
Link Camera... Nogfe:
Interactive View Link

Step #6: You get this dialog box — /

now click in the other Window that
you want to be linked with

Your Windows now share a single transformation

Oregon State
University
Computer Graphics

mjb — August 25, 2023

Multiple Views with Linked Viewing Transformations 76

Click on another view to link with.

If you click on this checkbox and —
then click in another Window . 7"————__ |  Hiteracwe ven e

... you get a Magic Lens \

2
5
H
H

Oregon State
University
Computer Graphics|

mjb — August 25, 2023
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Order Matters! ”

Senderent 18 3 8 x

Dne State
Universil

Computer Ggphics

Using Plot Over Line 8
_?i_pe_[i_ne Browser Renderview |_E[II E_HEEHZ‘

Create this Pipeline
Split the Render window and ask for a Line Chart View
When you click in the Render window, make the eyeballs
look like this, with the TableToStructuredGrid
representation set to Outline and the Glyph representation
set to Surface

Oregon State
University
Computer Graphics

mjb — August 25, 2023
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line Brovser
@ builtin:
ﬁ scalar.csv
é TableToStructuredGridl
[1_1-@ Calculatorl
é] Contourl
— W Glypht

o oene|
LN

N\

1. Click in the Line Chart View window. Add a
PlotOverLine filter that is parented to the
TableToStructuredGrid

2. Setup the PlotOverLine Properties like this

3. Be sure Auto-Apply is turned on

Oregon State
Universil
Computer Graphics

Using Plot Over Line

79

== Properties (PlotOverLinel)
Sampling Pattern | Sample Uniformly
Resolution 1000
Line Parameters
Length: 3. #5469
Show Line

Point1|-1.00377 -0.987287

Paint2| 1 11

Flip Vector

to the clesest mesh point.

||-1.01024
IE8

'P' to place alternating points on mesh or ‘Ctri+P' to

"1'f'Ctrl+1’ for point 1 and "2'/"Ctrl+2" for point 2.
Use N’ to place P1 on the mesh and make P1-P2 be the normal

at the surface.
Use X'/'Y'['Z' /'L’ to constrain the movementtothe X /Y [ Z |
Line axis r:ﬁpec?._iuelv_

X Axis Y Axis Z Axis

Q
iC

mjb — August 25, 2023

line Brovser
@ builtin:
ﬁ scalar.csv
é TableToStructuredGridl
[1_1-@ Calculatorl
é] Contourl
— W Glypht

o oiene]

\

Setup the Display (XYChartRepresentation)
Properties like this

Oregon State
University
Computer Graphics

Using Plot Over Line

80

Attrbute Type | « Point Data
X Axis Parameters

Use Index For Xaxis
XArray Name | arc_length

Series Parameters

/w/'?’mntsj

® O romz

BHE
e 6| e
e

Line Thickness
Line Style
Marker Style
Marker Size
Chart Axes

= View (Line Chart View)
Title
Chart Tite
Annotation

V! Show Legend

SortBy X-Axs
Left Axis
Left Axis Tite
Left Axis Range
Left A Log Scale
Left Axis Use Custom Range
Bottom Axis
Bottom Axis Tite
Bottom Axis Range
Bottom Axcs Log Scale

Bottom Axis Use Custom Range

== Display (XYChartRepresentation)

=] [c} Variable
@ G romsmagntude
® O romx

wtivalidPointMask

Q
| =l

Legendtame ||

Points Magnt..
Points X 8
Poits 1

Points 2

s

S

ValidPoIntM...

TR =ARUgUST 25, 2023

40



8/25/2023

81

Using Plot Over Line

Now, when you click on the Line erXpoints and move them, the graph changes

Oregon State
University
Computer Graphics

mjb — August 25, 2023
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Comparative Visualization

2

scalarcompare.pvsm

University
Computer Graphics
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Comparative Visualization

83

ParaView can setup a side-by-side visualization comparison with different vis

parameters in each view.

Start by creating a 3D Render view visualization. This case is using the
isosurface demonstration shown earlier.

1 bt
I seaaress
4 @ Tablerosmiuredintt
LIS T
= ) Calulazors
3 Bomma

Properties | Information
propertes B

% Dalete

Compute Geadients
¥ Generate Trisngles
Isosurtaces
Value Range: [0, 153 96]
12 +

= Display (GeometryRepresent e

AL =+

Reoresentaton  gumace

mjb — August 25, 2023

Comparative Visualization

Now, split the window

| Renderviewd m)B3/8 x|

‘Create View
Render Vien

and select:

}

Render View g mwvercomeng T >

(Comparative). e

Bar Chart View
Bar Chart View (Comparative!
Box Chart View
Functonalgag Chart View
Histogram View
Line Chart View
Line Chart View (Comparaive)
Orthographic Sice Vien
Parallel Coordinates View
Plot Matrix View
Python View

84

Dlwoars

3
§

Quartie Chart View
slice View

i

Spreadsheet View

You can now eliminate the left-hand

window if you want.

N

Renderview1 M8 0)/f X
S

niversity
Computer Graphics

Pipeline Browser
H =
[ builtin:
1

= scalar.csv

phi

é Contourl

TableToStructuredGnd1

=8 Calculatorl

Click all the eyeballs on
I— for the visualization
features you want to see.

mjb — August 25, 2023
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Comparative Visualization

ources Filters Extractors Jools Catal

Animation View

Collaboration Panel

Comparative View Inspector
BpeAne B1OW 3] [rformation
buit
B b Light Inspector
Discig :
L lemory Inspector
@ @bl i
Multi-block Inspector
*» @ .
. L Y] Output Messages
@ @ Y Pipeiine Browser
V| Properties
Pythan Shell
Selection Display Inspector
5 Statistics Inspector
Properties
oot Time Inspector
| B, preview
Apph
3 Full Screen
[search V| Show Frame Dacorations
= Dyl B Toggle Lock Panels

85

11

Select View —» Comparative View Inspector

These two areas are created

Oregon State
Universil
Computer Graphics
mijb — August 25, 2023
- - = - 86
Comparative Visualization
Here’s where you get to select how to
vary the parameter(s).
Select the layout dimensions of
the comparative window grid
parative View Inspector
Select the pipeline module that e < =+ = 2
Over comparisons.
roeeis Lt owns the parameter \ e
|Properties &8 X aram
e || Dt || Rpewe [ 7
[search ... (use Esc to dear text) 2 SeIeCt the parameter
= Prﬁuas(conwuvl} 2 ENCEE . . .
Gnoumos | Hit the Big Plus Sign
[ compute Hormals
[ compute Gradients
[ Compute Scalars
[ Generate Triandles N
e
Yolsasangert, 155.96] + Contourt Tsosurfaces -]
120 \'-[{d“t?avamdﬂ]l
‘Comma-separated values accepted.
] [x-] [
[ = o e | 3 65 (@ W
Representation ‘51,(@95 v‘

=14
Oregon State
University
Computer Graphics

Color Map Editor | Comparative View Inspector |

mib — August 25, 2023
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Comparative Visualization 87

‘Comparative View Inspector 8 x

o [ T

[ Overtay all comparisons

Parameter

Contourlisosurfaces

(0 | [Contourt v | 1sosurfaces -

Conma-separated val
B

%0 &

u/

ParaView stocks the number grid with evenly-spaced values and
applies them to each visualization, respectively.

Usually, these are not what you wanted to see. But you can
type your own numbers in each cell

(I eliminated the Glyphs to better see the isosurfaces)

The windows are all transform-linked

Cootup e compuana e ipec

mjb — August 25, 2023

Cc

omparative Visualization 8

Clicking Overlay all comparisons, well, overlays all comparisons

You can vary multiple

parameters — just setup multiple pipeline elements and

parameters and put numbers separated by commas in the cells

In this case, now could be a good time to also vary the opacity of the isosurfaces

‘Comparative View Inspector
Layout: x|z |=
| Overlay all comparisons

Parameter

® |Con10ur1rlsusurlaoe5

Oregon State
University
Computer Graphics

~ 16751
— 15000
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Comparative Visualization

€l
Computer Graphics
mjb — August 25, 2023

90

Visualizing Vector Data

2

vector.csv

3
\EE

Oregon State
University
Computer Graphics
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Oregon State
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Creating Vector Data in a CSV File

X32,¥32,232,Vx,Vy,Vz

-1.00,-1.00,-1.00,2.00,2.00,2.00
-1.00,-1.00,-0.94,1.75,1.75,2.00
-1.00,-1.00,-0.87,1.53,1.53,2.00
-1.00,-1.00,-0.81,1.33,1.33,2.00
-1.00,-1.00,-0.74,1.15,1.15,2.00
-1.00,-1.00,-0.68,0.99,0.99,2.00
-1.00,-1.00,-0.61,0.84,0.84,2.00
-1.00,-1.00,-0.55,0.71,0.71,2.00
-1.00,-1.00,-0.48,0.60,0.60,2.00
-1.00,-1.00,-0.42,0.49,0.49,2.00
-1.00,-1.00,-0.35,0.40,0.40,2.00
-1.00,-1.00,-0.29,0.31,0.31,2.00
-1.00,-1.00,-0.23,0.24,0.24,2.00
-1.00,-1.00,-0.16,0.17,0.17,2.00
-1.00,-1.00,-0.10,0.10,0.10,2.00
-1.00,-1.00,-0.03,0.03,0.03,2.00

Do a File - Open and navigate to your CSV file.
Hit the Apply button to actually do the read.

vector.csv

91
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How to Read the Vector Data in the CSV File

' 4

vector.csv

e

Oregon State
University
Computer Graphics

Froperties | Information

Properties &3
® Delete T
== Properties {TableToStructure || = | o il = =
Whole Extent |,
0
¥ Column
¥ Column
Z Column

92
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Computer Graphics

Pipeline Browser =
H buitin:
Wi
: a @ TabieToStructuredGrid1
 buitr: Fr @ cdaiatrs |
[jve:mrsv [j o
@ ructuredord < ==
@ @ TableTostructuredGrid 1
Q lg L
@ Properties | Information
@ Wjcyoht Properties =
Apply. @ Reset % Delete. " ?
Propertey _ Information Propertes Information Search . oo Exc o
Pvpuehes & X Properties. a
== Properties (Glyph1) S ]
2 Reset § Delete ? Aoply D Reset { Delete ?
rchn .. (ke Est to clear tex)) 165 [search .. fose Ese to dear text) B Qaenyve [arrow >) =
8 5 (o] [d@] Snsuaia
AobueNode [pontoota Bl I ) =
[ Coordnate Resuits | e
e~ a— . IR x
[mest0 ] Serae—— - oz x][C
Clear C L ) [ Het || yat || krat Masking
T | Gy toce Unform St Distrbuton GoundsBssed)
asin acos atan ceil foor | - Maximum Number Of 5000
s | cosh | teh | xy | ew | = za"‘:”"'"‘s
wivz | mag | nom | I | lgw | [ = L
Scalars - Vectors. - == Display (GeometryRepresentation] | Clle
Coloring
1 LR /B
Styling.
oty ———;
Add the 2 Calculator s
filters for now. The .
Etny
reason will be explained Sclngede | A grmamte -
in the next slide. os s s B

mjb — August 25, 2023

Why Are the Two Calculator Filters There? 94

Pipeline Browser

B buitn

[ Jvectorcsy
@ @ Tabkostuctrederidy
) Caleulator1
ﬁ Caleuiator2

=

B buitin:

Bl cicirr

T
@ ) TableTostructuredGrid1

= B

Pipeine Browser &
] buitin:
vector.csv
@ éTab\EToStruch.llEdGridl

Calculator1

Point Data
[] coordinate Resuits

@ Calclator2
@ W[chphi
Propertes  Information —
Properties B X\ leoperties a
- Apply 3 Reset  Delsie 2 Apply 2 Reset { Delete ?
. (use Esc to dear text) [Search ... {use Esc to dear text) |

= Properties (Caloulatort) || (9| |y @ | ||~ = Properties (Calaulator2) BB R

Attribute Mode = Attrbute Mode  [point Data =

[ Coordinate Results

T vy Name [ygg > |
ey>

Hat kHat

i +
o

x*y =
_in I

\
The vector.csv file brought in the three vector components Vx, Vy,

and Vz. ParaView's vector vis filters want a 3-element vector instead.

Calculator1 is used to create that 3-element vector using the iHat,
jHat, and kHat buttons (unit vectors in x, y, and z) :

V=V,i+V,j+V,k

V(Ie want to color the vector
visualizations by the magnitude of the
vector. Calculator2 computes that
magnitude using the mag button:

Mag = ||V||

Y — AuyuSt 29, 2uy

8/25/2023
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Why Are the Two Calculator Filters There? %

(= o> 0 16 0]

Attribute Mode i}’b‘ﬂtﬂaﬁl o |

[ coordinate Results

Result Ar ) |

Attribute Mode EPohtDaiz - |

[ Coordinate Results

Result Aray N Tvag |
)

VcHat+y SHat -+ Hat E——

| clear (| ) et jHat || kHat > Cear T T 1) |l Hat || jHat || kHat
~sn || cos || @n | abs || sqit + sn || s || tn | abs | sat |[ +
Casn | acos || atan | cel | floor || - | asn || acos | aten || cel || fioor =
[soh | cosh |[ toh | x*y [ e [ = [sinh | cosh [ nh || %y [ e |[ = ]
[vivz | mag [ nom | i | login | [ vivaQmag > nom || I [ legto || |

| Sealars - Vectors - | Scalars l Vectors b

V=V,i+V,j+V,k

Oregon State
University
Computer Graphics

Mag = V||

mjb — August 25, 2023

= Propertes Ghohi)
Glyph Source
& Gvph Type | Arrow ) - |

O Ay | VD -
e —
Scale

[ Scale Array ) -
et m—— o %[O
Masking N
/
Ghyph ode | Uniform Spatial Distribution (Bounds Based) |

Maimum Huomber OF T
Sample Pointe. [Re |

Seed |10339 |

D\

== Display (GeomeltryRepresentation]

Representation | Surface |

Coloring
Q- vag ~ -

\ it J[ o] | ]| e
Styling

Opadity
Lighting
Specular ™

=

Ray Tracing
ScalingMade | Al Approximate: - |

Org

Ui
Comp Data Axes Grid | Edit |

Setting Up the Glyph and its Coloring

96
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25, 2023

A

builtin;
5 vector csv
@ B TsbkToStuchredaid L
Caleulator1
) Callatorz

Properties | Information 1
roperties =
o apply @Reset | Mpeete | ?

|search ... (use Esc to dear text)

| = Properties (streamTracer1)

| —
Vectors [ =¥

/

Integration Direction | BOTH v/

Integrator Type | Rungautta 45 /|

LM:W SEMiNG | ‘Ziﬂzllﬁ[
Seeds
| Sccde

Seed Type | Point Cloud -

[ | show sphere
Center|o o / ) |
gl | [4

Note: Use Tl +P' to snap to the
‘mesh point

Number Of points | 100 = > |

RN |
| = Display (GeometryRepresentation ﬂg\ﬂ =]
Representation | surface |

Colori

s ][

[ BaEat [C3EIES (BN

Computer Gréphics

As Streamlines

second Calculator

Will start the streamlines from within this
sphere. You can move it and resize it.

Number of points to start from

StreamTracer filter, parented from the

98
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Computer G}ayphics
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100

8 v As Ribbon Traces

[ vactor.csv
e ‘Tab\eToStmmlredGridl
s Calculatorl

- B calaulatorz |_— Note — Ribbon is parented from StreamTracer.
@ Glypht
StreamTracerl

Ribbon Traces are especially good for showing
twisting in the vector field. This dataset is not a great
example of that.

Properties | Infarmation
Properties

A The Scalar setting tells what will be used to size the
e | @eee | wose |7 L~ \idth of the ribbons.

|search ... {use Esc to dear text) /]Tfé

== Properties (Ribbon1)

The Vector setting tells what will be used to decide
which way the ribbon is facing.

rSealars

- T =
RS * Normals -
Width = 0.00779705 Hi”£|
Angle =i |

Use Default Normal i

Default Normal | |lo IE |
K (v vary wicth >

= Display (GeometryRepresent | 1| || S || |
—
Coloring
| = v — i
[ mean |[@][=][n][s) =] 0] @]

mjb — August 25, 2023
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Q. : ;
%\%F/
Oregon State
University
Computer Graphics
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As Streamtubes 102

] buitn:
I vectorsy
@ B TableTostructuredGridt
© Clalatort
© calalatorz

[~ Note — Tube is parented from StreamTracer.
Properties | Information
Properties

Apply @reset | MDelete | ?

“ MNormals

Humber of Sides | g

V| Capping

Radius e (0,0101961 | %

= Display (GeometryRepresent ||

E Sl
Representation | gyface =
Coloring
e Mag - -
s Edit ||z s 5 iR
TITveTITCy—
Computer Graphics

mjb — August 25, 2023
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Streamtubes are Especially Useful if You Want to Map '™
Scalar Values to the Streamlines

In this case, we will map curvature (defined by the curl of the vector field)

B buitin: | = properties (PythonCalculato |'I‘_"D Cuilil - A |

[ vector.cov " e —
@ @ TebleTostructurederid: e |E“rlm |
@ écmmlamn 01 | Pgint Data 57
@ ﬁ Caleulator2 |Curl |
@& W clyph1
X e Copy Arrays
@ @streanracer /
@ éTuhel /] Coloring

e
L7

The Python Calculator filter w;
of the vector field (it has a
Calculator does not)
The StreamTube’s coloring was changed from Mag to Curl
The color mapping was changed to cut down on the amount
of blue (lots of low curl values)

used to produce the Curl |
t-in curl( ) function — the

Curl Magnitude
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Functions Available in the Python Calculator

Oregon State
University
Computer Graphics

area( dataset)
aspect( dataset)
cos( array)

cross( X,Y ) where X and Y are two 3D vector arrays
curl( array )
divergence( array )
dot(a1,a2)
eigenvalue( array )
eigenvector( array )
gradient( array )
max( array )
mean( array )

min( array )

norm( array )

sin( array )

strain( array )
volume( array )
vorticity( array )

From: https://www.paraview.org/Wiki/Python_calculator_and_programmable_filter
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Visualizing Terrain Data

terrain.csv

<z
Oregon State
Universil
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Creating Terrain Data in a CSV File

UTMx512,UTMy361,Z,Longitude,Latitude,Elevation
-6909.865,-6870.170,1174.991,-122.200,45.010,1174.991
-6882.896,-6870.356,1268.436,-122.198,45.010,1268.436
-6855.759,-6870.542,1308.478,-122.196, 5.010,1308.478
-6828.789,-6870.728,1266.755,-122.193,45.010,1266.755
-6801.820,-6870.911,1203.239,-122.191,45.010,1203.239
-6774.682,-6871.095,1127.675,-122.189,45.010,1127.675
-6747.544,-6871.279,1074.388,-122.187,45.010,1074.388
-6720.575,-6871.461,1060.748,-122.185,45.010,1060.748
-6693.606,-6871.642,1056.135,-122.182,45.010,1056.135
-6666.468,-6871.823,1050.158,-122.180,45.010,1050.158
-6639.499,-6872.002,1029.548,-122.178,45.010,1029.548
-6612.361,-6872.182,1001.763,-122.176,45.010,1001.763
-6585.391,-6872.360,975.069,-122.174,45.010,975.069
-6558.254,-6872.539,980.551,-122.172,45.010,980.551
-6531.284,-6872.715,1029.739,-122.169,45.010,1029.739

Do a File > Open and navigate to your CSV file.
Hit the Apply button to actually do the read.

UTM data is in meters, which makes a more reality-looking base
than longitude and latitude do. It is good to have both Z and
Elevation, even though they are the same number because once
you use a variable for a geometric dimension, you can'’t also use
D{J‘* it again for a data value (e.g., to color or contour by elevation).
Computer Graphics
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Reading and Converting the CSV File

Pipeline Browser

|i| builtin:

This will bring up a table window
to confirm that the data has been
read properly. You can delete
this now if you want.

=1 properties. i (5] ﬂ

ol Extent [ [su1

Jo |3e0

UTMx512

9
YCom iyt
N
I'=‘Displav(stmctumd€ﬁdm DB & \e

Representa o

Coloring

@ soid Color -0

D
P

ow, go to

Oregon State
Universil
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N:ilters — Alphabetical —» TableToStructuredGrid

Fill in the Whole Extent boxes showing the first and last
index in each dimension (the last index is one less than the
number of points in that dimension).

Fill in the {X,Y,Z} Column information so ParaView knows

how to make your 3D display.

Hit the Apply button to actually do the conversion.

Be sure the Representation is Surface

mjb — August 25, 2023

The Correct Scale Factor

Pipeline Browser

|i| builtin:

Ij terrain. csv
- :
N\tl{Trarlsform‘l

110

This will bring up a square terrain, which isn’t what we
want. We notice that the UTM coordinates are 511 and
360, so we really want to scale by 5"/,5, = 1.4194 in

the X direction.

Now, go to

Filters — Alphabetical - Transform

Set the X scale factor to 1.4194

/

Bl JJ

Transform ITransForm
I show Box

Translate1[l JD
Rotate |0 0 lo

¥
scale (1.9194 |1 |1
¥ Translation " Scaling
¥ Rotation [V Face Movement

¥ Transform Al Input Vectors
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Color by Elevation 12

Try coloring by Elevation.
The heart icon brings up
popular color scaleg. You
can pick one of thesg or
sculpt your own.

Coldandtot D N o Green-Orsnge
[ PE— B O oGtk

[ons

Color tapping parame]

Cologing

| o Ervaﬁon |
: e N

Ll

Oregon State
University
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Elevation
3.332e+03

2500.3

=5.592e+00

ST 4
Oregon State
Universil
Computer Graphics
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Contouring 4

Bl buitin

t terrain.csv
o @ TobleTostructurederidt
@ @ ronstomt

Properties | Information
Properties

Apply @resst | Wpeete || 2

|search ... (use Esc to dear text) K

= Properties (Contour1) 22|«

fontour By | * Elevation

V| Compute Normals

Compute Gradents

V| Generate Triangles

[5.592, 33319}

Now, go to
Filters — Alphabetical - Contour
Nand select Contour by Elevation

+ ParaView gives one default contour elevation, but you can add
more.

 Representation | Wireframe — v . .
\}ﬁ, = —Display as Wireframe.

Coloring

== Display (GeometryRepresentation]

| @ sold cobor = ~
G ; — [ Edit to select a contour color.
i Enter a Line Width.

Opacty —

newidih |3

Renderies s Tubes Be sure the eyeballs are turned on.

TOMPUICT Grapmics

mjb — August 25, 2023
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ST 4
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Changing the Vertical Exaggerations e

Re-click on the Transform filter, turn on the

Box, and move the scaling knob

Transform | Transform
.
W show BD
N— T |
Translate 0 llo |lo |
Rotate |0 llo o |
Scale | 1.4194 Il 1 |
Interactivity Controls
v | Translation V| Scaling
V| Rotation | Face Movement
| Reset Bounds |
W | Transform All Input Vectors

S g
Oregon State
University
Computer Graphics
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Reading ARCGIS DEM Files "
| was able to get to get two DEM files loaded into ParaView, and while
not straightforward it's not too hard to do. You need to load in the file, add
the Extract Surface filter to it, and then the Warp By Scalar filter.
Without these filters, ParaView will leave your data as a 2D surface.
d
3
D{Jeg,_m)n S_late Louis Panton
niversi
Computer Graphics
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g . f
vector.pvsm
parallelcoords.pvsm
A==
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Parallel Coordinates — Correlating Fields

T
B buitin:

Let’s say you were to start with this: [ vector.cov
| airebieTosbucturedarid |

B Calaiztor1

B calaator2

B chyphz
=) StreamTracer1

|
@ Tube1

CICICI ]

Either convert the Render View window to a Parallel Coordinate View window by
right-clicking anywhere in the window header bar, or by splitting the window\
A\

119

DlovoteiX |+ \
Fu OB ERE ARPEEERAA LN ﬁ

@ spit Horizontal
B splitVertical

Render View
Render View (Comparativel
Bag Chart View

Bar Chart View

Bar Chart View (Comparative)
Box Chart View

FunctionalBag Chart View
Histogram View,

Line Chart View

Line Chart View (Comparative)

Python View
Quartile Chart View
Slice View,
SpreadSheet View

mjb — August 25, 2023

Parallel Coordinates

Splitting the window looks like this. Select Parallel Coordinates View.

L4 ol AR AP ER A 200 Renderview1 0|80 [&][x]

Create View
Render Vien

Render View (Comparative)
82g Chart Vew
Bar Chart View

|Bar Chart View (Comparative)
Box Chart Vien

FunctionalBag Chart View

Histogram Vien
Line Chart View

Line Chart View (Comparative)

w
Paralel Coordinates View

Python View
— 3.5e+00 —
Quartie Chart view
y 3 Shee View

l Spreadsheet View
a6/

Oregon State

120

uare iy going to do it the first way to give more room for the Parallel Coordinates display.

Computer (
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Parallel Coordinates

Bl builtin:
@  [Elvectorc
@ B TableTostructuredGrid:
@ Eicdstor
@ @caator

@ th- Glyph1
> cODEEER
@ W Tubel

us more to look at.

| = bisplay (Paralieicoordinates || Y
Fild Association [point Data

Parametars

S

Mag
[ Normals x

[ Normals_¥

[ Normals 2
Normals_Magnitude
Rotation

Ovx

Ovy

Ovz

V_ Magnitude

[ Vorticity X

[ Vorticity ¥

[ Vorticity Z

farticity Magnitude

.

ly
vz

Variable
ngul
tegrationTh

e

TTIVETSIT

Computer Graphics

Turn the eyeballs on for the StreamTracer. It turns out
/ StreamTracer creates a bunch of derived variables, so this will give

121

The Parallel Coordinates Display Properties shows what
ariables will be displayed. No matter what, they are

So, click them all off and turn them back on in the horizontal
order you want to see them.

mjb — August 25, 2023

Parallel Coordinates

122

Series Parameters

Variable

Mag
ngularVelocity
frticity Magnitude

[ Nermals X
[ Nermals Y
[ Nermals Z
(] Normals Magnitudd
[] Rotstion

Ovx

vy

Ovz

1 Vorticity X

1 Vorticity_Y

O Verticity_Z

v

O vy

[mR%3

1 Pointe Maanitude

\

So, click them all off and turn them back on

in the horizontal order you want to see them.

You can left-click-drag them to a new vertical

position in the list to make re-clicking on
them in a different order much easier.

uregonstate
University
Computer Graphics

\

The narrowness of the bundle of lines
shows the strength of the positive and

negative correlations.
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Parallel Coordinates

Lots of (negative) correlation

Little correlation

Oregon State
University
Computer Graphics
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Parallel Coordinates

Scroll down a little more in the properties menu and you
will find the Parallel Coordinates Styling menu:

TTVz
O Points_Magnitude

Styling
oy
i

\’% Solid /

Line Thickness = 2

Line Thickness = 1

mjb — August 25, 2023




Therms on my Natural Gas Bill vs. Average Corvallis '*°
Low and High Temperatures
N = B These Parallel Coordinates
® 72 show that when temperatures
@ E G are high, natural gas
© . ® consumption goes down.
w o (Duh, ...)
?ﬁn . 52
Oregon State i " .
Universil
Computer Graphics Lo ek Hat
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Saving an Image of the Screen

scalar.pvsm

ot

<z
Oregon State
University
Computer Graphics
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File > Save Screenshot 127

I Save Screenshot

bﬁit View Sources Fifters Extractors To

7 x

e oo 0fE

Fiename

| T Open... Ctri+0 Lok [VParaien oatal
: a2
©) Recent Files > i pamerts
Dektop
Reload Files F5 Favorites
a

£ Load State...

', Save State..

af Save Catalyst State...

R Ctrl+5

Save Screenshot...

Steturessckpng

SteturesFrontpng

isosurtace pngpng

[ scalarpng

1) tmpeng
tonuzpng
wordtexpng

71 workdtetpng

Twe [5ee omeriosnes ]
Fade s

prg File 303.0KB 7/20/2017 7:45 AM

prg File 296.2KE 10/11/2017 1100 AM
prg File 107.5KE &/31/20177:43 AM
prgFile 1SMB /15720171225 PM
prg il 1SMB /15,2017 413 PM

Select the gear to
show all options

port Animated Scene..

(I recommend this)

£ Save Aot M Save Screenshot Options \ ? X
s, save Extracts... o
i Gl == N\ (&
| ave Geometry...
Size and Scaling N N
LoadPolh Incesdenialsy. Image Resolution | 1525 x| 1009 B x|8a|s
| i Load Window Arrangement... Font Scaling Scale fonts proportionally hd
7 Save Window Arrangement... Coloring
Override Color
W Connect... palette No change =
€ Discannect Stereatode | 1o change =
Transparent Background
=] Exit Ctrl+Q
Format
Compression Level | 5 3
1| Application Paraview +
=
Oregon State
University o Xl (
Computer Graphics ~—
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just long enough to create the screenshot

You can override the existing background color

M Save Screenshof Options ?

[f=ar

Size and Scaling

Image Resolution | §625 x| 1009 CAENE
Font Scaling cale fonts proportionaly

lor
[« Wl No change

Stereo Mode

No change

Transparent Background

Compression Level |5

1 Application ParaView

Xoancel || Pox |

\

Oregon State
University
Computer Graphics

Changing the Background Color 128

Mo change
Mo change
Black Backaground
Default Background
Gradient Background
Gray Background

| Print Background

You can also force the image background to be transparent.
(This only works on some image file formats, such as PNG.)
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Creating Stereographics Images 129
I 5ave Screenshot Options ? X
[Bearch .. (use Esc to dear text) > (T:\
sie _— N

. Image Resalution || 1009 m®) x]a]c
Turning on the —/ LR x]alS
-ont Scaling Scale fonts proportionally -

] /
Advanced Settings e
enables Stereo Mode L -

—

StercoMode | change

Transparent Backgy

‘Compression Level | 5 =
iNo change / 1| Agplication Paraview [
iNo change r | %

Mo stereo o|ld| X cancel @
Red-Blue

Interlaced
Left Eye Only
Right Eye Only
Dresden
Anaglyph
Checkerboard

Side-bz-Side Horizontal

N

Oregon State
University
Computer Graphics
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An Original Visualization 130

I ‘_ Linear Green (Grdl) [ et | I
r This is using the Linear Green color scale because it seems to work better
Oregon State for Red-Cyan Anaglyphs than do color scales with blue or red in them
University
Computer Graphics
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Side-by-Side Stereopairs

If you can parallel freeview, use the left two images.
If you can cross-eyes freeview, use the right two images

If you can’t do either, then never mind

g
a*.s
Oregon State
Universil
Computer Graphics
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Red-Cyan Anaglyph

027 Axs

0

02

Oregon State
Universil
Computer Graphics
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The Left Two Images Work Well Together in my
Handheld Stereo Viewer

Print this page and cut out the left two images

133

Note to self: don’t resize these images, as much as you are
tempted to — they fit perfectly in the viewer as they are now.

mjb — August 25, 2023

Exporting the Scene Geometry

.

scalar.pvsm

University
Computer Graphics
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You can export the scene geometry (in this case to Blender) via X3D files 135
File > Export Scene
You can also export the scene as a GLTF
file. | would guess that USD isn't far off.
A==
Oregon State
Universil
Computer Graphics
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You can export the scene geometry (in this case to Blender) via X3D files

Oreg—
U,-ﬂ “Should” be able to create STL files from legal solid geometry (e.g., isovolumes) this way, too
Computer Graphics
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Saving the ParaView State

anim.pvsm
scalar.csv
scalar.pvsm
scalar.py
vector.csv
vector.pvsm
vector.py
terrain.csv
a*.s terrain.. pvsm
terrain.py

Oregon State
Universil
Computer Graphics
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Saving the State in Either a Native Format 138

or as a Python Script

#H ParaView 5.6.0 64-bit
File Edit View Sources Filters Tools
' Open.. Ctrl+0
B Save State File 70X
Recent Files L3
Tidosd Files Fs Lookin: ¥ifParaView/Data/ 1o © O
Examples ~ || Filename
Lo; My Documents i
< Save Stk E::::Et':s scalarpusm
vectorpvsm
= i A
,* Save Data... Ctrl+5 DA
&1 Save Screenshot... 5:
Export Scene... < il >
7 Data
':3. Save Animation... Parta‘dlew
Save Geometry...
& Import Cinema Database...
Load OSPRay Materials... Fename: | [T ]
= - Fies of tyd€’ |Paraview state fle (= pusm) N\ *]| cancel
Load Window Arrangement... — Eag:f‘;“t:;“a:'i( Dva)
Save Window Arrangement... Al fles ()
,’." Connect...
& pisconnect “State” means the entire state of the user interface (pipeline,
= properties, etc.). The data is not part of the state. When you
Exit Ctrl . . . :
- Lt read the state back in, ParaView will prompt you to show it
Oregon State o q q .
University what data file you want included with this state.
Computer Graphics

mjb — August 25, 2023

8/25/2023

69



scalar.py

139

# state file generated using paraview version 5.1.2

#### import the simple module from the paraview
from paraview.simple import *

#### disable automatic camera reset on 'Show'
paraview.simple. DisableFirstRenderCameraReset ()

# Create a new 'Render View'

renderViewl = CreateView ('RenderView')
renderViewl .ViewSize = [1160, 912]
renderViewl .AxesGrid = 'GridAxes3DActor'

renderViewl.StereoType = 0

renderViewl.CameraParallelScale = 1.73205080756888
renderViewl .Background = [0.32, 0.34, 0.43]

# init the 'GridAxes3DActor' selected for 'AxesGrid'
renderViewl .AxesGrid.Visibility =1

# create a new 'CSV'
scalarcsv = CSVReader (FileName=['Y:\\ParaView\\Data\\scalar.csv'])

renderViewl.CameraPosition = [3.76687547966054, 5.62637881722241, 4.44163730510425]
renderViewl.CameraFocalPoint = [0.0241978424871666, -0.0474471125809167, 0.0405907851464954]
renderViewl .CameraViewUp = [-0.384789750616684, -0.393723993522038, 0.834816305989173]

Oregon State
Universil
Computer Graphics
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Animation in ParaView

anim.pvsm

Oregon State
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Animation in ParaView “
Select this:

Start with this:

Animation View

Color Map Editor

| Comparative View Inspector
V| Information e
Light Inspector anim.pvsm

Memory Inspector
Multi-block Inspector
V' Output Messages
V| Pipeline Browser
V| Properties
Python Shell

Selection Display Inspector

Statistics Inspector

Time Inspector

[ Preview b
5 Full Screen F11

V| Show Frame Decorations

And this appears at the bottom: 5 Toggle Lock Pansis
Animation View B
Mode: | Sequence ~ |Time: 0.00 |0 of (TDB) Start Time: 0 || & End Time: |1 | £ [No. Frames: | 10

Time o 0.25 05 075 1

V| |TimeKeeper? - Time I

4| | Contour1 ~ | | Tsosurfaces -

mjb — August 25, 2023

Animation in ParaView — Pick Something to Animate '*

Conveniently, the user interface for animation in ParaView looks a lot like the user
interface for Comparative Visualization:

Select a Pipiline Elementand a Paran\eter within that Element

== Properties (Contour) = ==

Contour By [ _ ¢

v Compute Normals

Compute Gradients

v Generate Triangles 0 0.25
Isosurfaces ; ;
Value Range: [0, 168.96)
140 +| T
=] = Isosurfaces
%|[x][C
Hit the + when you are done
Animation View
— -- T Mode: |Sequence ~ |Time[0 [start Tme: o
#l Contour1 l - [ Time .000e+40 2.000e-01
Camera TimeKeeperl - Time
Python (
scalar.csv ntour L
A efeTIET
AR A Point Merge Mewoa =
g@ 5 Point Merge Memog - Divisions (1)
Point M Me -Di 2)
> ot Mihad - N o points per bucat
\E‘LE/ g points p
Visbilty
Oregon State Gpecty
University
Computer Graphics
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Animation in ParaView — Bring up a Keyframe Menu '

The, double-click in the white space to the right of the Property-Parameter you selected:

Animation View B
[Mode: | Sequence > |Time: 0.00 o of (TDB) Start Time: |0 £ |End Time: |1 D No. Frames: 10

Time 0 .25 0.5 075 1

1 | ' ' ' ' ' ' '

V| | TimeKeeper1 - Time

I A}
® ||V | contour - Isosurfaces (-1 |0 — \ b
< | Contourt + | | Isosurfaces -

9

a*.s

Oregon State
Universil
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Animation in ParaView — Setting Parameter Keyframes '

BF Animation Keyframes ? x
P e Click New to add a new row
Interpolation Value New )/
i Homp Delats The first column is the Time,
¥ e Bete Al the third column is the
# Ramp Parameter value at that time.
7 Ramp
T By default, the Time starts at
0. and goes to 1. — | just left it
that way.
| did change the 10 frames to
100 fYfames, though.
0K Cancel

Animation View / &
o — Sl el Bletmels  J (Ol rmeln ¥
Time 0.333333 0.666667
¥ | Timekeeperl - Time
3 | | Contour! - Isosurfaces {-1) o P of
b | [contourt =] [isosurfaces =
D —RUgUst 25, 2023
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Animation in ParaView — the Time Inspector

Select this:

0T

urces  Filters Extractors Tools Catalyy

e olbars v

V| Animation View

Collaboration Panel

Color Map Editor

<

Comparative View Inspector

<

Infarmation
Light Inspector
Memory Inspector
Multi-block Inspector
Qutput Messages

<

Pipeline Browser

<

Properties
Python Shell

Selection Display Inspectar

Statistics Inspector

| B Time Inspector
——————_

B, Preview
% Full Screen F11

V| Show Frame Decorations

[ Toggle Lock Panels

Oregon State
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Unless you've been living in a cave, you know
what to do with these — hit Play:

1> Bl 55 || e
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Animation in ParaView -- Animating the Camera

Here’s how to animate the Camera — select Camera from the list of

Prop

146

ies and select one of these from the list of Parameters, then hit the *+:

o
Follow Path

Follow Data

Interpolate camera locations

Orbit: animate the camera in a circle around a specific point
Follow Path: set keyframes for the camera position and look-at point

Follow Data: ?7?

Interpolate camera locations: Manually specify keyframe camera locations

97

a*.s.

Oregon State
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Animation in ParaView -- Orbiting the Camera 147

By default, the Center (look-at point) is the center of the data currently selected in the Pipeline.
The Camera start\at its Origin and orbits at its current radius around that point.

/

T\ Createf/Crbit ? >

Orbit Pgrameters

centy [0 |lo.267125 | [0.238025 |
Norfial |-0.213653 | |0.822086 | |-0.527783 |
Orign (450233 | |3.4738  |[[3m827 |

Reset Bounds Cancel

E.*E
Oregon State
Universil
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Saving the Animation 148

B ParsView 5.6.0 64-bit *
=
( File E View Sources Filters Tools ]
pen... Ctrl+0
Recent Files L
Reload Fifes F3
Load State...
Save State..
= s | You can then set some
% SaveData. i+ s = i i
S e — animation parameters.
Export Scene.. L.
— Clicking Save
R I O A = t- b ; H8 Save Animation Options ? x
ST nimation brings up
i a file navigator T
) r -
Load OSPRay Materials... d|alog- YOU can j;::,::w: alc
= . . 871 x|370 x| 8|5
o e save the animation Font Scalg | 5o onte propertionally =
 Save Window Anangement.. in either AVI or OGV s
ool -
& Connect formats. Queride COOr [ o change .
i Disconnect 2
Stereo Mode No change -
=L citg Transparent Background
File Options
Format  Vide: Windows
Quality 2 (best quality, larger file) -
(Cxﬂ:mwessur Four 1420
o
‘ l--- olld
L5

i
| haven’t done an exhaustive study of this, but | can tell you that OGV files play in Firefox, Edge, and Chrome —

but not in PowerPoint. AVI files play in PowerPoint. The OGV files are much smaller than the AVI files.
mjb — August 25, 2023
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References 149

http://cs.oregonstate.edu/~mjb/paraview

Utkarsh Ayachit. The ParaView Guide:
A Parallel Visualization Application, Kitware, 2015.

A free PDF of the book can be found here:
https://www.paraview.org/paraview-guide/

The ParaView tutorial:
https://www.paraview.org/Wiki/The ParaView_Tutorial
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ParaView

http://cs.oregonstate.edu/~mjb/paraview
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